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GettinG Started
Line 6 Spider IV Edit is the free editor/librarian application designed to allow you to more easily 
create and customize limitless Tone Presets for your Spider® IV amplifier. This document provides 
information on connecting & configuring your Spider IV amp, and using the Spider IV Edit software 
with your Mac® or Windows® computer. Let’s get started!

For details about your Spider IV amplifier’s features, please also be sure to read the Spider IV Pilot’s 
Guide & Advanced User Guide, available for free download from the Spider IV Online Help site!

System Requirements

We recommend that you read the separate, Spider IV Edit Release Notes document for the full, 
detailed System Requirements, as well as up-to-date info on compatibility with other hardware and 
software. This document can be found within the Line 6 Support Community, or on the Spider IV 
Online Help page.

• Line 6 Spider IV Edit supports the following computer operating systems:

• Mac OS® X versions - 10.4.11 (Tiger®), 10.5.x (Leopard®) or 10.6.2 (Snow Leopard®).

• Windows® versions - Windows® XP Service Pack 3, Windows Vista® Service Pack 2, or 
Windows® 7.

• Spider IV Edit is a 32 bit application, but is compatible with both 32 bit and 64 bit  Mac 
OS® X and Windows® versions.

• Line 6 Spider IV amplifier, model 75, 120, 150 or HD150, with Spider FX Infusion update 
(firmware version 1.50, or later) is required.  

• Computer connectivity - A Line 6 FBV Shortboard™ MkII or FBV Express™ MkII with 
firmware version 1.10 (or later) is required to utilize the Spider IV Edit application with a Spider 
IV amplifier (see “Making the Connection” on page 1•2 for details).

Obtaining Software & Hardware Updates

Since you are reading this guide, you likely already have Spider IV Edit installed. But, should you ever 
need to obtain the installer again, or check for an updated version, everything is just a few clicks away! 
As mentioned above, you’ll also want your Spider IV amp and FBV™ MkII Series Controller have the 
latest firmware. The easiest way to do all this is to run the Line 6 Monkey utility, which is installed 
along with the Spider IV Edit software. Please see “Line 6 Monkey & Additional Resources” on page 
3•1 for details. Alternatively, you can download the latest Line 6 software and firmware from the Line 6 
Software Downloads site.

Please also see the Spider IV Edit Installer Guide, available from the Spider IV Online Help site. 

http://line6.com/support/
http://line6.com/software/
http://line6.com/software/
http://line6.com/manuals/spideriv/
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Making the Connection

To put Spider IV Edit to work, you’ll need to connect your Spider IV amplifier to your computer via a 
Line 6 FBV MkII Series Controller device to establish two-way communication. First, exit any Line 6 
applications that might be running, then proceed with the following steps.

FBV MkII Connection

Connect an RJ45 cable from the “FBV Pedal” jack on the back of your Spider IV amp to the “To Amp” 
jack on your FBV MkII. Then connect your FBV MkII to your computer using the USB connection. 
Of course, the RJ45 cable connection is what you use for controlling your Spider IV via your FBV 
MkII. However, once you then connect your FBV MkII to your computer, this switches the FBV 
to “USB mode,” establishing communication between your Spider IV amp and Mac® or Windows® 
computer! (Note that FBV MkII will not control your amp when in USB mode.)

Connect RJ45 cable from 
amp to FBV MkII

Connect USB cable from 
FBV MkII to your computer

For info about the FBV MkII controller capabilities, please see the additional documentation available from 
the FBV MkII Online Help site. 

Power Up

Once the above connections are made, make sure your amp and devices are powered on, then launch 
Spider IV Edit:

• On Mac®, go to Applications > Line 6 > Spider IV Edit

• On Windows®, go to the Start button menu > Programs > Line 6 > Spider IV Edit

Upon launch, the application will detect your Spider IV and automatically retrieve and load all the 
amp’s current Tone Presets. If no connected amp is detected, you’ll see an alert at the bottom of the 
application window:

If you see this alert, exit the application and check that your amp and FBV MkII are correctly connected 
and powered on, as instructed in the previous sections. 

http://line6.com/dispatch/?appid=2097217558&page=manuals
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Note: It is possible to disconnect your amp from your computer to run Spider IV Edit in “Offline Mode” 
(see page 2•12). However, the application may not display the above alert when disconnected after the 
application is already launched. You must exit the Spider IV Edit application before re-connecting your 
amp, then relaunch the application to allow it to detect the amp once again.

With your devices all configured and connections successfully established between the Spider IV Edit 
application and your Spider IV amp, you are now ready for some serious tone tweaking! Proceed to the 
next chapter for info on using the software.
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the Spider iV edit application
The previous Getting Started Chapter covered getting you wired and ready with Spider IV Edit & a 
Spider® IV amplifier. In this chapter, we’ll provide you with an overview of the features and functions 
found within the Spider IV Edit application. All functionality is the same on Mac® or Windows®, 
unless otherwise noted.

What’s in it for Me? 

Spider IV Edit a simple, but powerful, editor/librarian software application. It allows you to easily see 
and tweak all the individual amp & effects models’ parameters within one attractive Graphical User 
Interface (GUI), where you can create and customize your own Tone Presets, backup and store an 
unlimited number of Preset files on your computer, and send them to your Spider IV amp’s User Bank 
locations, in whatever Channel order you prefer. You can also tap into the Line 6 CustomTone™ site 
where you can share your Spider IV Tones, and download from the huge library of artist & user Presets!

Workflow Overview

Once the Spider IV Edit application is launched, it automatically “receives” the complete set of stored 
Presets from your amp’s User Bank into the application, allowing you to view or customize any amp 
& effects models’ settings. While the application is connected, communication between it and your 
Spider IV amp’s internal memory is instant - adjust any parameter within the application’s loaded 
Preset and the modified settings are heard on your amp. Likewise, adjustments made to your amp’s 
controls are also reflected in the software. 

This interactive communication allows you to tweak any individual amp or effects models’ settings 
within the application GUI and instantly hear and preview the changes made on your Spider IV amp. 
These settings changes are stored in the “edit buffer” of your Spider IV amp’s memory - meaning, they 
do not overwrite the stored settings until you choose to save the amp Preset. You can also move the 
Tone Presets to different User Bank locations (01A through 16D) within the application, to manage 
the contents of your amp’s User Bank Presets’ order. Once you are done with your Tone tweaking, you 
can “send” one or all the current Tone Presets from the application to your amp, to save all settings 
within your amp’s internal memory. You can also choose to save Presets to your computer’s hard drive 
to build a library of Tones, which you can reload into the application, and to your amp, at any time. 
Read on for a tour of the application’s features!

Graphical User Interface

In software speak, the main window of the Spider IV Edit application is referred to as the Graphical 
User Interface (or “GUI” if you want to sound hip around your software buddies). Here we’ve laid out 
descriptions for all the important things you need to know as you start clicking around in there. 

http://line6.com/customtone/
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Save Panel

Presets Panel

Signal Flow Panel

FX Panels

Amp Panel

Save Panel

The buttons within the Save Panel allow you to “Send” or “Receive” Tone Preset data between the 
application and the amp’s internal memory. Using these Send buttons overwrites the existing Preset 
data in your amp’s internal memory, effectively Saving the transferred Preset(s) to your amp.  

The Save Panel

Note that the selected (highlighted) Preset may not be the one currently loaded in the editor - The Send 
Selected and Receive Selected buttons act only on the selected Preset(s).

• Send Selected button - Transfers the currently selected Preset (or multiple selected Presets*) 
from the application to the amp, overwriting the respective Presets within the amp’s internal 
memory.  

 *Tip: To select multiple Presets, hold Shift or Ctrl while clicking within the application’s Presets Panel!

• Send All button - Transfers all Presets (regardless of any selected Presets) from the application 
to the amp, overwriting all Presets within the amp’s User Bank locations.
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• Receive Selected button - Transfers the currently selected Preset(s) from the amp to the 
application.

• Receive All button - Transfers all Presets from the amp to the application.

Note that the editor always “receives” the amp’s stored Preset settings, even if the selected Preset(s) are 
currently in an edited state.

Presets Panel

The Presets Panel lists Channel locations (01A through 16D) that correspond to the respective  
numbered User Bank Channel locations within your Spider IV amp’s internal memory. Each of these 
locations is capable of storing one Tone Preset, which you can access here to load and customize its 
settings. 

Channel number

Currently loaded Preset 
(indicated by arrow at left)

Selected Preset 

The Presets Panel

• Load a Preset - Double-click directly on any Preset’s Channel number to load its settings into 
the editor, or hit “Enter” on your computer keyboard to load the currently selected Preset. (Also 
see “Saving and Opening Spider IV Preset Files” for info on opening Presets stored on your 
computer.)

• Select a Preset - Click once directly on any Channel number to select its Preset. Note that this 
does not load the Preset in the editor, but rather allows you to perform actions on the Preset - 
such as to “Send” or “Receive” Presets  (see “Save Panel” on page 2•2). It is also possible to select 
multiple Presets: 

• Press and hold your Shift key + left click to select a contiguous number of Presets.

• Press and hold your Ctrl key + left click on the desired Presets to select a non-contiguous 
number of Presets.
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• “Insert” a Preset into a different Channel location - Click on a Preset and drag it up or down 
within the Presets Panel. Drop the Preset onto the desired Channel location to move the Preset 
there. This action “re-orders” other Presets within the Channel locations accordingly to insert 
your dragged Preset into the new location.

 

Note: Since the “insert” action re-orders Presets in the application, all the moved Presets are now in 
different Channel locations as compared to the Channel contents within your amp’s User Bank and, 
therefore, are marked as “unsaved” in the Presets Panel. Use the Send buttons in the “Save Panel” to save 
the new Channel settings to your amp.  

• “Swap” the Preset settings between two Channel locations - Click on a Preset to select it. 
Then press your Shift key and left-click and drag the Preset to the new desired Channel location. 
Drop it directly within the new Channel slot and you’ll see the two Presets “swap” locations.

• Copy & Paste a Preset to a new Channel location - Click on a Preset to select it. Then press 
your Option key (on Mac®) or Ctrl key (on Windows®) and left-click and drag the Preset to the 
new desired Channel location. Drop it directly within the new Channel slot and you’ll see the 
dragged Preset’s name & settings copied into the new location.

• Save a Preset to your computer - There are a few ways to save a copy of the currently loaded  
Preset to your computer:

• Use the File menu’s “Save As” command (see page 2•10 for more about saving  and opening 
Preset and Bundle files). 

• Drag a Preset from the Presets Panel directly onto your Desktop, or into any folder on your 
computer. Or, select multiple Presets within the Presets Panel and drag and drop to save 
each as a separate Preset file in one action!

• To rename a Preset - Select the desired Preset, then left-click or right-click once directly on the 
Preset name. You’ll see the Preset’s name become highlighted in blue. Type in your own text and 
hit the Enter key.

Note: Changing the name of the Preset in the Presets Panel is not reflected on your amp until you “Save” 
the Preset to your amp, via the Send functions in the “Save Panel”.  

• Unsaved Preset Indicator - Whenever a Preset’s settings or name has been changed from the 
saved state of the Preset that resides in your amp’s internal memory, an asterisk (*) indicator  
appears to the right of the Preset name in the Presets Panel. Use the Send buttons within the 
“Save Panel” to “Save” edited Presets to your amp’s internal memory.

An asterisk indicates the Preset is in an “unsaved” state
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Signal Flow Panel

The Signal Flow Panel provides a handy visual reference of the enabled/disabled state and signal flow 
position of the amp & effects models for the loaded Preset. 

Gate     Volume   Wah       FX-1      Amp    FX-2      FX-3      Reverb

The Signal Flow Panel

Enabled/Disabled State

The FX-1, FX-2, FX-3, Wah and Reverb models each include an enable/disable “LED” button (found 
at the left of their “Effects Edit Panels”). The icon for the respective effect within the Signal Flow 
Panel dims to indicate its disabled state:

FX-1 Enabled FX-1 Disabled

Model Position

The position you see the models appear in left to right in the Signal Flow Panel is precisely the order 
your input signal flows through them. Note that when you toggle an effect’s “Pre/Post” position switch 
(available within FX-1, FX-2, FX-3 and Reverb “Effects Edit Panels”), the Signal Flow Panel display 
dynamically changes to show you the new amp & effects ordering.   

“Pre” position “Post” position 

Amp & Effects Panels

These panels provide you easy access to the individual parameters of each amp and effect model that 
make up your Tone, making deep editing of your Spider IV Tones easier than ever! As noted earlier, 
changes you make to any of the settings within these panels are immediately reflected on your amp, 
allowing you to hear the changes instantly. Note that these customized settings are stored only in 
the Spider IV amp’s “edit buffer” -  meaning, the changes to the amp’s Preset are temporary until you 
choose to save the Preset to your amp. Saving is achieved by using the “Save Panel”, or by using the 
Save functions on the amp itself.  
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Working with Panel Controls

You’ll find that most controls within these Edit Panels look and function just like those on your Spider 
IV amplifier itself. However, since we’re in the software world here, there are additional ways to access 
controls in all these Panels! To follow are functions that are common within Edit Panels.

• Knob controls - Click and drag any knob control vertically to adjust its value. Or, click to 
“select” a knob and then use your computer’s arrow keys or mouse wheel to adjust it. Most knob 
controls also include a numerical indicator/edit box that provides access to the parameter value 
as well (see the following description).

• Mix knob value indicators - When adjusting the Mix knob within any of the Effects Edit Panels,  
you’ll see the following two indicators to assist you in dialing in the desired setting:

Tooltip value indicator

Mix value display

Adjusting an Effects Edit Panel’s Mix knob

• Numerical indicator/edit boxes - All the amber boxes that show numerical values serve not only 
as handy indicators for your settings; you can also click and drag up/down to adjust their values, 
or double-click within any box to type in a specific numerical value.  

Double-click and type in a valueClick and drag vertically

• Enable/Disable effects models - At the left of the FX-1, FX-2, FX-3, Wah and Reverb Edit Panels, 
you’ll see a little “LED” control. Click directly on this LED to toggle the model between enabled 
or disabled. You’ll see the LED and all edit boxes dim to indicate the model’s disabled state. Note 
that you’ll also see the model’s icon within the “Signal Flow Panel” dim when disabled.   

FX-1 Enabled

FX-1 Disabled
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Amp Edit Panel

Tap Tempo Amp model menuTone & Level

BoostAmp selector

• Amp model selection - Use the familiar rotary Amp selector knob at the left of the panel, or 
click on the Amp model menu to select an amp model by name.

• Boost Pre & Post controls - Use the knobs here to adjust the amount of volume boost applied 
individually for “Pre” and “Post.” Click on the LED to toggle the Boost function on/off.

• Tap Tempo controls - Click rhythmically, directly on the LED here to “tap” in a tempo for your 
Modulation (FX-2) and Delay (FX-3) effects models to follow (see “FX-2 & FX-3 Edit Panels” 
on page 2•8). The edit box below indicates the numerical tempo value. Alternately, you can click 
and drag, or double click on the Tap edit box and type in a specific BPM value. 

Effects Edit Panels

Below the Amp Edit Panel you’ll see a dedicated Edit Panel for each of the 7 effects that are available 
within your Spider IV Tone Preset. For all Effects Edit Panels, except for the Gate and Volume, a Model 
menu is available at the right where you can select from a list of effects models. You’ll see that the 
controls displayed within the Edit Panel are specific to the model selected. To follow are descriptions 
of the controls within the Effects Edit Panels (also see page 2•6 for common Edit Panel options).

FX-1 Edit Panel 

Effects model menuModel-specific controls

Enable/Disable LED switch Pre/Post position switch

• Pre/Post position switch - Toggles the effect’s position within the signal chain to be before the 
amp (“Pre”) versus after the amp (“Post”). You’ll see the exact position of the effect reflected 
within the “Signal Flow Panel”.  

• Effects model menu - Click the down arrow to select from the list of models. The FX-1 panel 
offers a large assortment of Dynamics, Filters and “Stomp” type effects to choose from (overdrives, 
distortions, fuzzes, compressors, EQs and more!). 

Note: See “FBV MkII Pedal Control” on page 2•12 for info on controlling the FX-1 Pitch Glide effect with 
your FBV MkII pedal!
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FX-2 & FX-3 Edit Panels

The FX-2 & FX-3 Edit Panels include all the same controls as the FX-1 panel (as described above), 
as well as an additional “Tap” control. The FX-2 panel offers several tasty Modulation type effects 
(phasers, choruses, rotary speaker, etc.). The FX-3 panel offers an arsenal Delay type effects (analog & 
digital echoes & delays).

Tap selector Speed control

Tap selector Time control

• Tap “Control” selector - For any effect model selected within the FX-2 or FX-3 Edit Panels is 
the option to select “Control” or “Don’t Control,” allowing you to choose to have the effect 
follow the current Tap tempo value, as configured within the “Amp Edit Panel”. You’ll also see 
the following controls in these Edit Panels:

• FX-2 Speed - This knob & edit box allow you to configure the Modulation rate of the 
selected model. With the Tap selector set to “Don’t Control,” you can set any Hz value. 
With the Tap selector set to “Control,” this knob is disabled.

• FX-3 Time - This knob & edit box allow you to configure the Delay time of the selected 
model. With the Tap selector set to “Don’t Control,” you can set any ms value. With the 
Tap selector set to “Control,” this knob is disabled.

Reverb Edit Panel

Pretty straight-forward here... The Reverb Edit Panel offers the same set of controls as the FX-1 Edit 
Panel. Within the Effect Model menu you’ll find a number of Reverbs in assorted flavors.

Gate Edit Panel

The Gate effect is always in a fixed position (the first item in the signal chain), so no Pre/Post switch 
is offered. Also, note that there is no Enable/Disable LED switch at the left of the panel, however, you 
can select “Off” within the Mode menu.

Mode menu

• Mode menu - Select between a “Gate” (a Noise Gate), “NR” (Noise Reduction), both, or “Off.” 
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Wah Edit Panel

Like most other Effects Edit Panels, the Wah Panel offers an LED Enable/Disable switch and model 
menu. The model menu offers several classic Wahs for your choosing. The Wah effect is always in a 
fixed in the “Pre” signal flow position, so no Pre/Post switch is offered.

Audition control

• Audition - Use the knob or edit box to adjust the Wah’s sweep. As its name suggests, this control 
is simply to allow you “audition” the Wah effect - its setting is not saved with the Preset. It’s a 
really a lot more fun to use an FBV MkII pedal to work the Wah with your foot!

• Enable/Disable LED switch - This allows you to save the Wah’s enabled/disabled state with your 
Preset.*

*Note: See “FBV MkII Pedal Control” on page 2•12 for information about the Wah settings & behaviors 
when optionally using your FBV “Wah” pedal for the Pitch Glide effect.  

Volume Pedal Edit Panel

The Volume Pedal effect is always “on” and, therefore, offers no Enable/Disable LED switch. If you are 
utilizing your Line 6 FBV MkII pedal to control the Spider IV Volume Pedal feature, use the controls 
in this panel to edit the pedal behavior.

Minimum & Maximum pedal controls

• Min & Max controls - Use controls to limit the Min (“heel down” position) and Max (“toe 
down” position) values for your controller pedal. 

• Pre/Post position switch - Toggles the Volume pedal’s position within the signal chain to be 
before the amp (“Pre”) versus after the amp (“Post”). You’ll see the exact position of the effect 
reflected within the “Signal Flow Panel”.

Tip: You can get some different textures out of your amp & effects by changing the Volume pedal & 
effects’ Pre/Post placement. For example, placing the Volume pedal before an Echo can provide a smooth, 
cinematic swell, or, positioning the Volume pedal before your amp or a distortion pedal allows more control 
over the amount of gain. Modulation effects can sound different before versus after distorted Amp tone. 
Feel free to experiment!
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Menu Commands

To follow are descriptions of the application’s menu commands and their functions. The location of 
some commands are different on Mac® versus Windows® systems, as noted below.

Spider IV Edit (This menu is shown only on Mac®)

• About Spider IV Edit - Launches the About box, which includes info about your connected 
hardware and software version.

• Quit Spider IV Edit - Exits the application.

File (Also see “Saving and Opening Spider IV Preset Files” on page 2•10.)

• Open - Allows you to load a saved Spider IV Edit Preset (.s4e) file from any folder on your 
computer. 

• Save As - Allows you to save a copy of the loaded Preset as a Spider IV Edit Preset file (.s4e) to 
any folder on your computer. 

• Save Bundle - Allows you to save all current Preset settings as a Spider IV Edit “Bundle” (.s4b) 
file to any folder on your computer. 

• Load Bundle - Loads a saved Spider IV Edit “Bundle” (.s4b) file from any folder on your computer, 
replacing all Presets within the application. 

• Exit (Windows® only) - Exits the application.

Window (This menu is shown only on Mac®)

• Minimize - Minimizes application window.

Help

• Spider IV Edit Help - Launches this PDF document you are now reading.

• Online Help - Takes you directly to the Line 6 Community site, the place to find additional 
documentation, FAQ’s, User Forums, Technical Support, breaking news and more!

• CustomTone.com - Takes you to the Line 6 CustomTone site, where you can share your Tone 
Presets with thousands of other Line 6 users, and download free Tones from the huge library!

• About Spider IV Edit (Windows® only) - Launches the About box, which includes info about 
your connected hardware and software version.

Saving and Opening Spider IV Preset Files

Note that there are two methods for “Saving” within the Line 6 Spider IV Edit application. The 
Save Panel allows you to “Send” one or all Presets from the application to your amp, overwriting     
the existing Presets within the Spider IV amp’s User Bank locations with the Preset data from the 
application’s respective Channel locations. For more about this form of Saving, please see the “Save 
Panel” on page 2•2.

The other way to “Save,” as covered here, is to create a copy of any Preset to any folder on your 
computer as a Spider IV Edit Preset file (.s4e) file. This allows you to create a library of .s4e Preset files 
that can be reloaded onto your Spider IV amp anytime! 
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To Save a Preset to your Computer:

• Double-click on a Preset within the application’s “Presets Panel” to load it and select “Save As” 
from the File menu. This launches the familiar Mac® or Windows® file “Save As” window, where 
you can edit the file name and choose a destination folder. By default, all .s4e files are saved in 
the following location:

• On Mac® - /Documents/Line 6/Tones/Spider IV Edit folder

• On Windows® - \My Documents\Line 6\Tones\Spider IV Edit folder

• It is also possible to drag any Preset from the Presets Panel and drop it onto your Desktop, or 
into any folder on your computer to copy it there. Or, select multiple Presets in the Presets Panel 
(using  Shift+left click or Ctrl+left click) to drag and Save copies of all in one drop!

To Save a Bundle to your Computer:

Spider IV Edit allows you to instantly save all the applications’ current Preset settings into one, 
consolidated “Bundle” (.s4b) file. This is extremely handy for making a complete backup of all your 
current Presets, allowing you to load them all back to your amp at any time! Just go to the File menu 
and select “Save Bundle” to launch a “Save As” dialog, where you can enter a name and choose any 
folder to save the Bundle file (the default Preset/Bundle folder is shown on page 2•11). Note that the 
Save Bundle feature always includes all 16 Banks of Presets, regardless of any Presets(s) that might be 
selected within the Presets Panel.

To Open a Preset or Bundle File from your Computer 

• Select “Open” from the application’s File menu and browse to the location where your Preset 
(.s4e) files are stored (the default Preset folder is shown on page 2•11).

• Selecting a Preset file loads its saved settings, replacing the currently loaded Preset and its 
Channel location within the application. 

• Alternatively, you can drag a Preset  or Bundle file from any folder on your computer and drop it 
directly in the Spider IV Edit window to load the file’s settings. 

Spider IV Amplifier - Manual Mode & Quick Loop

The amp’s “Manual Mode” and “Quick Loop” functions are not supported by the Spider IV Edit 
application. These features are still available via the amp’s on-board switches while using Spider IV 
Edit, however, there are no functions within the application’s GUI to specifically control or save 
Manual or Quick Loop Modes. The following behaviors apply:

• If you set your Spider IV amp into Manual Mode or one of the Quick Loop Modes (Ready 
to Record, Loop Record or Loop Playback) the application simply remains showing the same 
currently loaded Preset, even though your amp’s Tone may be changed as you adjust its on-board 
amp or FX controls.       

• When the amp is in Manual or a Quick Loop Mode, clicking on the application’s Save Panel - 
Receive button will receive the stored Preset from the amp’s internal memory (rather than the 
amp’s Manual Mode settings). The amp remains in its current Manual or Quick Loop Mode.

• Double-clicking on an edited Preset within the Presets Panel loads the edited Preset settings in 
the application and on the amp:
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•  If the amp is currently in Manual Mode, this action will force the amp out of Manual Mode, 
and the new Preset settings will be loaded on the amp. 

• If the amp is currently in any one of the Quick Loop modes, it will simply remain in this 
mode, and the new Preset settings will be loaded on the amp. 

Spider IV Edit - Offline Mode

In some cases, you might want to retrieve all the Presets from your amps’ internal memory into 
the application, and then be able to edit the Presets, without your changes being sent to the amp 
automatically. To do this, connect your amp to your computer first, then launch the Spider IV Edit 
application. Once all Preset data has been received into the application, simply disconnect your 
amp from your FBV MkII connection. With no amp connection, you can now use the application in 
“Offline Mode.” The application will not detect that the amp has been disconnected (you will not see 
the “No Line 6 Device Connected” alert at the bottom of the application window).* However, you 
can still edit the Presets with the application in Offline Mode, and then save any to your hard drive. 

Or, perhaps you want to load one of your saved Bundles from your hard drive, tweak, rename or reorder 
your Presets and save the Bundle back to your computer without committing it to your amp just yet? 
No problem! Just launch Spider IV Edit without your amp connected to work in Offline Mode. Load 
your Bundle file using the File menu’s Load Bundle command (or Command+L on Mac®, Ctrl+L on 
Windows®), edit to taste and save the Bundle back to your computer. When you want to save the 
Bundle to your amp, connect your amp before launching Spider IV Edit, then launch the application, 
load the Bundle, and use the Save Panel’s Send All function to save the Bundled Presets into your 
amp’s User Bank locations.

 

*Note: The Spider IV Edit application will not automatically detect your Spider IV amp if you connect (or 
if you disconnect & re-connect) the amp after the application has already been launched. You’ll need to 
exit the application, connect your amp to your computer, and then launch the application. The application 
will then automatically “Receive” all Preset data from your amp’s internal memory.

FBV MkII Pedal Control

As covered in the Spider IV Advanced User Guide, a Line 6 FBV MkII controller can be used to control 
the Wah, Volume & FX-1 Pitch Glide effects. Here are a few helpful notes about the FBV MkII pedal 
behaviors.

• For most Presets, you’ll see that the FBV “Wah” pedal controls the Wah effect, and the “Vol” 
pedal controls the Volume effect as the default settings. 

• For FBV Shortboard MkII & FBV Express, push the on-board pedal full forward and click 
the toe switch to toggle its function to either “Wah” or “Vol.”

• For FBV Shortboard MkII, if you have an expression pedal connected, the expression 
pedal then controls the “Vol” function, and the on-board pedal becomes dedicated to the 
“Wah” function.
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• Alternatively, you can configure the FX-1 Pitch Glide effect to be controlled by either the FBV 
MkII “Wah” or “Vol” assigned pedal, by way of the Pitch Glide’s “FBV” setting. Here’s how to 
access the option in the FX-1 Effects Panel:

Select the Pitch Glide model

Choose your FBV pedal control option

• The Don’t Ctl setting, as you might guess, leaves the “Wah” and “Vol” pedals assigned to 
controlling the Wah and Volume effects.

• The Wah:Glid setting assigns the “Wah” pedal to control the Pitch Glide effect. Note that 
this means that any Preset saved with this setting will not have its Wah effect controlled by 
the “Wah” pedal. Likewise, the Wah effect’s Enable/Disable switch (when switched either 
by the pedal’s toe switch or by the editor’s Wah Edit Panel LED switch) will toggle the 
Pitch Glide effect. These settings are saved with the Preset - so be sure to save the Wah as 
“enabled” if you want the Pitch Glide active when you recall the Preset! 

• The Vol:Glid setting assigns the “Vol” pedal to control the Pitch Glide effect. Note that 
this means that any Preset saved with this setting will not have its Volume controlled by 
the “Vol” pedal.
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line 6 Monkey & additional reSourceS
Line 6 Monkey™ is the intelligent updater utility automatically installed with the Spider IV Edit 
application, or available from line6.com/monkey. It is highly recommended that you run Line 6 Monkey 
often to be sure you have all your Line 6 products updated and registered. Registration is required for 
some Line 6 hardware to allow you to perform updates, and also very important because it ensures that 
you’re dialed in for warranty service and makes it possible for us to contact you if new updates or cool 
enhancements are offered - cutting edge technology and such! So don’t put this off any longer. 

Run Line 6 Monkey

With your amp connected to your computer (see “Making the Connection” on page 1•2), be sure your 
amp & devices are all powered on, then launch Line 6 Monkey:

• On Mac®, go to Applications > Line 6 > Line 6 Monkey

• On Windows®, go to the Start button menu > Programs > Line 6 > Tools > Line 6 Monkey

Line 6 Monkey will present you with the option to choose either your FBV™ MkII or Spider® IV 
amp. (If Monkey instead automatically launches using your FBV MkII device, click on the Change 
Device button at the left of the Monkey screen to launch the device selection window.)

Note: If you have not yet registered your FBV MkII device, Line 6 Monkey will prompt you to do so. 
Registration of your FBV MkII is required before you’ll be able to obtain updates for your Spider IV 
amp. Just click the Register button when prompted and Monkey will guide you through the easy online 
registration.

http://line6.com/monkey/


3•2

Spider IV Edit: Line 6 Monkey & Additional Resources

If Monkey prompts you to register your Spider IV amp, then please do so now - it may be required 
to register to obtain some product updates. Follow the prompts and Monkey will walk you through a 
quick online registration. Return to Line 6 Monkey once you’ve completed the registration. 

Monkey will then display your amp’s current firmware version and any available updates. 

The Line 6 Monkey Updates screen, with Spider IV connected

In the above example, Monkey has detected that a newer Firmware - Flash Memory version is available. 
Select the Flash Memory item and click Update Selection. Be sure to read the prompts carefully and 
Monkey assist you in performing the update in minutes. It is especially important not to disturb the 
devices’ controls and cable connections until the update fully completes!
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Additional Resources

Hungry for more info? We’ve got plenty of helpful online resources, just a click away.

• Additional Help documentation covering Spider IV amplifiers and the Spider FX Infusion 
update:

Spider IV Online Help

• Additional Help documentation covering the FBV MkII Series Controllers:  

FBV MkII Online Help

• For Line 6 Support, including the searchable Knowledgebase:

Line 6 Support

• Can’t get enough of that Line 6 Gear & accessories? Head on over to the Line 6 Store!

Line 6 Online Store

• Visit the CustomTone™ site where you can share your Spider IV Tones with the world, and  
download free Tones created by Line 6 and other users just like you.

CustomTone 

• Join the Community! Pay a visit to the Line 6 Communities page, where you can find:

• Free Jam Tracks.

• Free loops for GarageBand®, Acid®, Reason® and more.

• Free guitar lessons from LA session pros.

• Free chord and scale practice tools.

• Information about contests and special offers.

• Access to discussion forums, software updates and more.

Line 6 Communities

http://line6.com/manuals/spideriv/
http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/support/
http://www.line6.com/store/storefront.html
http://line6.com/customtone/
http://line6.com/community/
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